MicroSEQ® Microbial Identification System Workflow

FAST 500 and FAST Fungal kits with the Veriti® Thermal Cycler, 3500 Series Genetic Analyzer, and MicroSEQ® ID Microbial Identification Software v3.0 or later

QUICK REFERENCE CARD

- Prepare DNA – PrepMan® Ultra Kit .......................... 2
- Amplify rDNA region of bacteria and fungi – FAST MicroSEQ® Identification Kits and Veriti® Thermal Cycler .......................... 3
- Purify PCR products – ExoSAP-IT® reagent .......................... 4
- Perform cycle sequencing – FAST MicroSEQ® Identification Kits and Veriti® Thermal Cycler .......................... 5
- Purify extension products – EdgeBio Performa® DTR cartridge or Performa® DTR Ultra 96-well plate .......................... 5
- Perform capillary electrophoresis of extension products – 3500 Series Data Collection Software v1.1 and MicroSEQ® ID Software v3.0 .......................... 6
- Review analysis results – MicroSEQ® ID Microbial Identification Software v3.0 .......................... 8

Workflow summary

Workflow best practices

- Recommended laboratory setup:
  - Area 1 – DNA preparation
  - Area 2 – PCR setup [no DNA in this area]
  - Area 3 – Post-amplification – PCR thermal cycling and purification, cycle sequencing and purification, capillary electrophoresis

For more information on suggested pipettes, refer to the MicroSEQ® Microbial Identification System Laboratory Setup, Materials and Equipment Reference Guide [Part no. 4453843].

- Recommended controls:
  - Process controls – User-supplied negative and positive controls. Include in all workflow steps and treat as a sample. [Negative control: Monitors contamination in the workflow. Positive control: Confirms performance of the workflow. Use laboratory strain.]
  - Reagent controls – Provided in the PCR kit. [Negative control: Verifies reagent purity. Positive control: Confirms reagent performance.]

- Sample handling:
  - To avoid cross-contamination, process and pipet controls/samples in the following order: 1) negative controls, 2) samples, 3) positive controls.
  - When possible, leave empty wells between negative controls, samples, and positive controls.
  - Before removing the tube, plate caps, or seal in any workflow step, briefly centrifuge the tubes or plate.
Prepare DNA – PrepMan® Ultra Kit

**Note:** For safety and biohazard guidelines, refer to the “Safety” section in the PrepMan® Ultra Sample Preparation Reagent Protocol [Part no. 4367554]. For every chemical, read the SDS and follow the handling instructions. Wear appropriate protective eyewear, clothing, and gloves.

### 1 Dispense PrepMan® Ultra reagent

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
</table>
| a. | Shake the PrepMan® Ultra Sample Preparation Reagent. Allow the reagent to settle until all the bubbles have disappeared.  
**Note:** To prevent contamination, do not pipet directly out of the PrepMan® Ultra Sample Preparation Reagent bottle into the sample tubes. |
| b. | Calculate the volume of PrepMan® Ultra Sample Preparation Reagent needed (number of samples ×100 µL). With a sterile pipette, transfer this volume of reagent into a 50-mL sterile conical tube or other sterile container. |
| c. | Label a set of 2-mL screw-cap microcentrifuge tubes (sample tubes). Dispense 100 µL of PrepMan® Ultra Sample Preparation Reagent into the sample tubes. |

### 2 Isolate DNA

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>a.</td>
<td>Using an isolated colony, select a small loopful of cells or the edge of a filamentous fungi colony on a culture plate (ideal colony size for bacteria and yeast: 1-2 mm; for filamentous fungi: 2-3 mm).</td>
</tr>
<tr>
<td>b.</td>
<td>Suspend the cells in the PrepMan® Ultra Sample Preparation Reagent in the appropriate sample tube from step 1c.</td>
</tr>
<tr>
<td>c.</td>
<td>Tightly cap the sample tubes, then vigorously vortex the sample tubes for 10-30 seconds to suspend the cells.</td>
</tr>
</tbody>
</table>
| d. | Place the sample tubes in a stand-alone heat block set to 100°C for 10 minutes.  
**Note:** To prevent contamination of the thermal cycler surface, do not heat sample tubes in the heat block of the thermal cycler. |
| e. | While the sample tubes are heating, label a second set of 2-mL or other appropriate microcentrifuge tubes. |
| f. | Remove sample tubes from the heat block. Cool to room temperature for 2 minutes. |
| g. | Spin the sample tubes at the highest speed for 2 minutes. |
| h. | Transfer 50 µL of the PrepMan® Ultra supernatant from the spun sample tubes to the second set of sample tubes from step e. Discard the remaining supernatant. |

**STOPPING POINT** The supernatant can be covered and stored at 4°C for up to 1 month or at –20°C for one year.

**Note:** For supernatant stored at –20°C, thaw completely, then vortex and centrifuge before use.
Amplify rDNA region of bacteria and fungi – FAST MicroSEQ® Identification Kits and Veriti® Thermal Cycler

Note: For safety and biohazard guidelines, refer to the “Safety” section in the FAST MicroSEQ® Protocols and the Veriti® Thermal Cycler User Guide (Part no. 4375799). For every chemical, read the SDS and follow the handling instructions. Wear appropriate protective eyewear, clothing, and gloves.

For detailed information on the procedures below, refer to the FAST MicroSEQ® Protocols.
For information on the Veriti® Thermal Cycler, refer to the Veriti® Thermal Cycler User Guide (Part no. 4375799).

1. Prepare PCR reactions
   a. Prepare a 1:100 dilution of the PrepMan® Ultra supernatant:
      **Note:** The minimum recommended dilution for the PrepMan® Ultra supernatant is 1:1.
      1. Label a third set of 2-mL or other appropriate microcentrifuge tubes.
      2. To each tube, add:
         • Add 495 µL of nuclease-free water.
         • Add 5 µL of the supernatant from the sample tubes in step 2h on page 2.

      **STOPPING POINT** The diluted samples can be covered and stored at 4°C overnight or at –20°C for up to 1 month.

      **Note:** For supernatant stored at –20°C, thaw completely, then vortex and centrifuge before use.
   b. Vortex the dilution tubes.
   c. For the Fast Fungal kit only:
      Prepare stock Reaction Mix: for each sample or control, add:
      • 14 µL of FAST PCR Master Mix (tube with yellow cap)
      • 2 µL of FAST Primer Mix (tube with red cap)
   d. Prepare samples and controls in MicroAmp® reaction tubes or 96-well plates:

<table>
<thead>
<tr>
<th>Reaction Type</th>
<th>Volume for One Reaction</th>
</tr>
</thead>
<tbody>
<tr>
<td>Negative controls</td>
<td>15 µL of Fast PCR Master Mix (Fast 500) or Fast PCR Reaction Mix (Fast Fungal)</td>
</tr>
<tr>
<td></td>
<td>15 µL of negative control (provided with kit)</td>
</tr>
<tr>
<td>Samples, process controls</td>
<td>15 µL of Fast PCR Master Mix (Fast 500) or Fast PCR Reaction Mix (Fast Fungal)</td>
</tr>
<tr>
<td></td>
<td>15 µL of 1:100 dilution of PrepMan® Ultra supernatant</td>
</tr>
<tr>
<td>Positive controls</td>
<td>15 µL of Fast PCR Master Mix (Fast 500) or Fast PCR Reaction Mix (Fast Fungal)</td>
</tr>
<tr>
<td></td>
<td>15 µL of positive-control DNA (provided with kit)</td>
</tr>
</tbody>
</table>

   e. Use strip caps and the capping tool, or adhesive film and the sealing tool, to seal the reaction tubes or reaction plate. Vortex, spin briefly, then place the tubes or the plate in the thermal cycler.
2 Perform the amplification run

a. Set the ramp mode to **Default**.

b. Set the Veriti® thermal cycling conditions:

<table>
<thead>
<tr>
<th>Initial Step</th>
<th>16S — Each of 30 cycles</th>
<th>D2 — Each of 35 cycles</th>
<th>Final Extension</th>
<th>Final Step</th>
</tr>
</thead>
<tbody>
<tr>
<td>Melt</td>
<td>95°C</td>
<td>95°C</td>
<td>64°C</td>
<td>HOLD</td>
</tr>
<tr>
<td>Anneal</td>
<td>10 sec</td>
<td>15 sec</td>
<td>1 min</td>
<td>4°C</td>
</tr>
<tr>
<td>Hold</td>
<td>4°C</td>
<td>4°C</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

C. Set the reaction volume to **30 µL**, then start the run.

**STOPPING POINT** You can cover and store the PCR products at -15 to -25°C until you are ready to use them. PCR products are stable for up to 6 months.

Purify PCR products – **ExoSAP-IT® reagent**

---

**Note:** For every chemical, read the Safety Data Sheet (SDS) and follow the handling instructions. Wear appropriate protective eyewear, clothing, and gloves. For more information on using this product, refer to the manufacturer’s instructions.

For more information on the procedures below, refer to the manufacturer’s instructions.

1 Prepare samples

a. Before removing the caps or seal of the reaction tubes or the reaction plate containing the PCR products, briefly centrifuge the tubes or plate.

b. For each sample, dispense 2 µL of ExoSap-IT® reagent into two MicroAmp® reaction tubes or two wells of a 96-well plate.

c. Add 5 µL of each PCR product from **step a** into the appropriate tubes or wells. Use strip caps and the capping tool, or adhesive film and the sealing tool, to seal the tubes or plate.

d. Cover and store remaining PCR product at -15 to -25°C for up to 6 months.

2 Incubate, then inactivate the ExoSAP-IT® reagent

a. Vortex the tubes or plate, then spin briefly.

b. Place the tubes or plate in a pre-programmed thermal cycler or heat block:
   - 37°C for 15 minutes to incubate
   - 80°C for 15 minutes to inactivate
   - 4°C hold

c. Set the reaction volume to **10 µL**, then start the run.

**STOPPING POINT** You can cover and store the purified PCR products at -15 to -25°C until you are ready to use them. PCR products are stable for up to 6 months.
Perform cycle sequencing – FAST MicroSEQ® Identification Kits and Veriti® Thermal Cycler

1. Prepare the cycle sequencing reactions
   
   - a. Before removing the caps or seal of the reaction tubes or the reaction plate containing the purified PCR products, briefly centrifuge the purified PCR products.
   - b. To one of the two tubes or wells for each sample from step a, add 13 µL of forward sequencing reaction mix.
   - c. To the other tube or well for each sample from step a, add 13 µL of reverse sequencing reaction mix.
   - d. Cover and store the unused portions of the purified PCR products at −15 to −25°C until you are ready to use them. PCR products are stable for up to 6 months.
   - e. Use strip caps and the capping tool, or adhesive film and the sealing tool, to seal the tubes or plate, then place the tubes or the plate in the thermal cycler.

2. Perform cycle sequencing
   
   - a. Set the ramp mode to Default.
   - b. Set the thermal cycling conditions:
     
     | Initial Step | Each of 25 Cycles | Final Step |
     |--------------|------------------|------------|
     |              | Melt | Anneal | Extend |          |
     | HOLD         |      | CYCLE |        | HOLD     |
     | 96°C 1 min   | 96°C | 50°C  | 60°C 1 min 15 sec | 4°C |
     | 10 sec       | 5 sec | 1 min 15 sec | ∞       |

   - c. Set the reaction volume to 20 µL, then start the run.

   STOPPING POINT Extension products can be covered and stored overnight at 4°C or for up to 1 week at −20°C before purifying them.

Purify extension products – EdgeBio Performa® DTR cartridge or Performa® DTR Ultra 96-well plate

Note: For every chemical, read the SDS and follow the handling instructions. Wear appropriate protective eyewear, clothing, and gloves. For more information on using these products, refer to the manufacturer’s instructions. For more information on the procedures below, refer to the manufacturer’s instructions.

Cartridges

1. Centrifuge the Performa® Gel Filtration Cartridge for 3 minutes at 850×g.
2. Transfer the cartridge to the 1.5-mL microcentrifuge tube (provided with Performa® kit).
3. Before removing the caps or seal of the reaction tubes or reaction plate containing the extension products, briefly centrifuge the tubes or plate.
4. Transfer the entire volume of extension product from step 3 to the filtration cartridge from step 2. Do not touch the sides of the cartridge. Be sure the fluid runs into the gel.
5. Close the cap and centrifuge for 3 minutes at 850 × g.

Plates

1. Remove the adhesive tapes from the top and bottom of an Performa® Ultra 96-well plate. Cover the plate with the plastic lid provided with the Performa kit.
2. Stack the Performa Ultra 96-well plate on top of a 96-well flat bottom plate (empty). Place the assembly in a cushioned centrifuge carrier designed to hold deep-well 96-well plates.
3. Centrifuge for 5 minutes at 850 × g.

4. Discard the eluate from the centrifuged plate.

5. Before removing the caps or seal of the reaction tubes or reaction plate containing the extension products, briefly centrifuge the tubes or plate.

6. Add the entire volume of extension product from step 5 in drops to the center of each well in the centrifuged Performa Ultra 96-well plate from step 4. Pipet slowly. Do not touch the sides of the wells. Cover the plate with the lid.

7. Stack the Performa Ultra 96-well plate containing the extension products on top of an empty 96-well semi-skirted capillary plate (provided with Performa kit). Place the assembly in the centrifuge carrier designed to hold deep-well 96-well plates.

8. Centrifuge for 5 minutes at 850 × g.

9. Retain the eluate.

**Perform capillary electrophoresis of extension products – 3500 Series Data Collection Software v1.1 and MicroSEQ® ID Software v3.0**

*Note:* For information on setting up for autoanalysis, refer to the *3500 Series Genetic Analyzer User Guide* (Part no. 4401661).

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>1</strong></td>
<td><strong>Review Data Collection software settings</strong></td>
</tr>
<tr>
<td></td>
<td>a. Double-click  and log in to the 3500 Series Data Collection Software v1.1.</td>
</tr>
<tr>
<td></td>
<td>b. <em>(As needed)</em> Select the <strong>Library</strong> workflow, then review and optionally edit factory-provided MicroSEQ ID run settings:</td>
</tr>
<tr>
<td></td>
<td>• Instrument protocol – Defines the application type and instrument settings to use in the MicroSEQ ID run, optimized for POP-6™ or POP-7™ polymer.</td>
</tr>
<tr>
<td></td>
<td>• Basecalling (primary analysis) protocol – Defines the basecalling and data analysis settings to use in the MicroSEQ ID run, optimized for MicroSEQ® ID applications.</td>
</tr>
<tr>
<td></td>
<td>• Results group – Used to name, sort, and customize the folders in which sample data files are stored.</td>
</tr>
<tr>
<td></td>
<td>• File name convention (FNC) – Specifies the naming convention for sample data files.</td>
</tr>
<tr>
<td></td>
<td>• Assay – Specifies the optimized instrument protocol and primary analysis protocol to use in the MicroSEQ ID run.</td>
</tr>
<tr>
<td></td>
<td>c. <em>(Before each run)</em> Review electronic signature (E-Signature) settings – If your Administrator has enabled the E-Signature function in the SAE module, make sure the <strong>Approve Plate</strong> E-Signature type is disabled.</td>
</tr>
</tbody>
</table>

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>2</strong></td>
<td><strong>(Administrators only) Set Auto-ID parameters</strong></td>
</tr>
<tr>
<td></td>
<td>You can use Auto-ID to assign a genus or species identification to a specimen in a project. Auto-ID parameters can only be applied to projects using a single library (proprietary or custom).</td>
</tr>
<tr>
<td></td>
<td>a. Close any open projects.</td>
</tr>
<tr>
<td></td>
<td>b. Select <strong>Tools</strong> » <strong>Options</strong>, then select the <strong>Auto-ID</strong> tab.</td>
</tr>
<tr>
<td></td>
<td>c. Select to turn <strong>Auto-ID On</strong>.</td>
</tr>
<tr>
<td></td>
<td>d. Select the kit(s) to apply Auto-ID parameters to during project analysis.</td>
</tr>
<tr>
<td></td>
<td>e. <em>(Optional)</em> Edit Auto-ID parameters for a selected kit.</td>
</tr>
<tr>
<td></td>
<td>f. Click <strong>OK</strong> to save your changes.</td>
</tr>
</tbody>
</table>
3 Create a new MicroSEQ ID run

- Double-click and log in to the MicroSEQ® ID Software v3.0.
- Click Create MicroSEQ ID Run on the MicroSEQ ID software main window. If prompted, log in to the Data Collection software.
- Complete the information in the MicroSEQ ID Run Wizard.
  1. In the Project Setup tab:
     - Specify run settings – Enter a MicroSEQ ID run name. Select the file name convention (FNC), default results group (RG), and project analysis report to use for all project data in the run. Enter the number of library matches to display when viewing search results. **Note:** If Auto-ID is enabled for the kit in the project, the minimum number of matches must be set to 7 for Auto-ID to occur (see step 2 on page 6).
     - Click Add Project to add a new project, then specify project settings – Enter a project name and the number of specimens in the project. Select the kit, project analysis protocol and libraries to use for project analysis, and the autosampler plate position for the project.
     - Click Next.
  2. In the Specimen Setup tab:
     - Specify plate properties – Enter a plate name for each plate assigned to a project. Select the assay[s] to use for data collection and analysis.
     - (As needed) Update specimen properties – Edit the specimen name[s] assigned to a project. Select a new results group to use for a specimen.
     - Click Next.
  3. In the Plate Layout tab, review and optionally edit the default well assignments.
  4. In any tab, click Save to save your changes without closing the MicroSEQ ID Run Wizard.

4 Prepare samples

- Before removing the tube caps or plate cover of the purified extension products, briefly centrifuge the extension products.
- Pipet samples into a 96-well plate, using the well assignments from step 3c:
  1. Pipet 10 µL of each purified extension product into separate wells in a 96-well plate.
  2. Pipet 10 µL of Hi-Di™ formamide into each well containing purified extension product and each blank well that will be injected together with samples.
    **Note:** Extension products can be injected directly without the addition of formamide. However, you may observe a greater variability of signal across capillaries, and evaporation may occur with electrophoresis run times longer than 24 hours.
- Cover the 96-well plate, then centrifuge.
- Cover and store the unused portion of the purified extension products overnight at 4°C or for up to 1 week at –20°C.

5 Start the MicroSEQ ID run

- Make sure your Administrator has properly configured the E-Signature settings in the Data Collection software (see step 1 on page 6).
- Load the 96-well plate into the instrument.
- In any tab of the MicroSEQ ID Run Wizard, click Run to start the MicroSEQ ID run.
### Monitor the MicroSEQ ID run progress

In the **Run Progress** tab of the MicroSEQ ID Run Wizard, monitor the status of the MicroSEQ ID run. During the run, you can view the:

- Injection status for each well [sample] in the run – ![Complete], ![In progress], or ![Not started].
- Analysis status for each specimen or project in the run – ![Complete and ready to view], ![In progress], or ![Not started].
- Completed analysis results (read-only) – Click an active link for a specimen or project with ![analysis status]:
  - **View Specimen** – Opens the specimen analysis report. Use this report to view Auto-ID results (if Auto-ID enabled, see step 2 on page 6) and library search results for the active specimen.
  - **Open Report** – Opens the project analysis report [set in the Project Setup tab, see step 3c on page 7]. Use this report to view the analysis results for the active project.

**Note:** After the run is complete, the analysis results are automatically saved to each project in the run, and the links become inactive. To view the results for a project, open the project and view the reports and project information together (see “Review analysis results – MicroSEQ® ID Microbial Identification Software v3.0”).

### Review analysis results – MicroSEQ® ID Microbial Identification Software v3.0

**Note:** For more information, refer to the *MicroSEQ® ID Microbial Identification Software v3.0 Getting Started Guide* (Part no. 4465137), or access the Help system by pressing F1, by clicking ? in the toolbar of the MicroSEQ ID software main window and in selected windows and dialog boxes, or by selecting Help > Contents & Index.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Open a project</strong></td>
<td>![Open Project](Open Project icon) on the MicroSEQ ID software main window.</td>
</tr>
<tr>
<td></td>
<td>If prompted, click ![Analyze samples](Analyze samples icon) to reanalyze the project.</td>
</tr>
<tr>
<td></td>
<td>In the Project Navigator pane, select the:</td>
</tr>
<tr>
<td></td>
<td>• Project name, to view the Analysis QC report (see step 2), the Library Search report [optional, see step 3], and the Project view for all specimens in the project (see step 4 on page 9).</td>
</tr>
<tr>
<td></td>
<td>• Specimen name, to view the Layout and Assembly views for that specimen (see step 5 on page 9).</td>
</tr>
<tr>
<td></td>
<td>• ![Sample name](Sample name icon) (Optional) Sample name, to view the results for that sample (see step 5 on page 9).</td>
</tr>
</tbody>
</table>

**Review the Analysis QC report**

<table>
<thead>
<tr>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Report Manager](Report Manager icon), then select <strong>Analysis QC Report</strong>.</td>
</tr>
<tr>
<td>![Window &gt; Tile &gt; Horizontal](Window &gt; Tile &gt; Horizontal) to display the Project view below the report.</td>
</tr>
<tr>
<td>Review for all specimens in the project:</td>
</tr>
<tr>
<td>• ![Auto-ID enabled](Auto-ID enabled icon) Auto-ID results – Review the Description column to troubleshoot any unidentified specimens and manually enter a specimen identification as needed.</td>
</tr>
<tr>
<td>• Specimen analysis results – Consensus and library entry length, % Match, % of Consensus Length attributable to the library match, and Specimen Score. Specimen Score values above 30 indicate high-quality values. If any Specimen Score values are below 30, review the results in the Specimen view (see step 5 on page 9).</td>
</tr>
<tr>
<td>• Analysis step (Basecalling, Filter, and Assembly) status symbols – ![Successful Analysis], ![Quality Alert], ![Failed Analysis]</td>
</tr>
</tbody>
</table>

**Note:** Click the “Legend Information” link to help troubleshoot any ![status symbols](status symbols icon) associated with a specimen.
3  **(Optional) Review the Library Search report**

a. In the left pane of the Report Manager, select **Library Search Report**.

b. Review for all specimens in the project:
   - **(If Auto-ID enabled)** Auto-ID results – Review the Description column to troubleshoot any unidentified specimens and manually enter a specimen identification as needed.
   - Library search results –
     - View all library matches for the selected project.
     - Determine if a match was made against a validated (proprietary) library or a custom [C] library.
     - View phylogenetic relationships between the unknown isolate and the top matches in an unrooted phylogenetic tree.
   - Concise alignment results – View concise alignment base variants by selecting **Window ➔ Tile ➔ Horizontal** to display both the Concise Alignment table and the Project view. Double-click the base in the Concise Alignment table to open the Assembly tab quality value location.

4  **Review the results in the Project view**

In the Project view:
- Check the % Match in the Library Search Results table.
- **(Optional)** Change the number of matches to display.

5  **Review the results in the Specimen and Sample views**

a. In the Specimen view:
   1. Select the **Assembly** tab.
   2. In the Project window toolbar, click **Show consensus QV**, **Show sample QV**, and **Show All Electropherograms**.
   3. Check the Sample Score for a specimen. If any Sample Score values are below 30:
      - Examine consensus and sample QVs. Check for medium (yellow) or low (red) QV bars. Medium or low values can decrease the Sample Score.
      - Examine the consensus and sample sequences. Check for incorrectly called bases (for example, a noise peak called as a base or a true base peak not labeled).
   
   **Note:** Refer to the *MicroSEQ® Microbial Identification System analysis and interpretation guidelines* (Part no. CO16970) for information on setting assay acceptance criteria.

b. **(Optional)** In the Sample view, select the **Annotation** and **Electropherogram** tabs and examine individual sample results.

c. **(As needed)** Rerun the sample.

6  **(If Audit set to Prompt) Select an audit reason**

If your Administrator has set the Audit Trail state to Prompt, an Audit Reason dialog box displays when an auditable event occurs.

Complete the information in the Audit Reason dialog box, then click **OK**. Your action is recorded in the Audit Trail report.

7  **Save the project**

After analyzing data and reviewing analysis results, click **Save Project**.

8  **(If eSig enabled) Electronically sign your work**

Your Administrator must enable the electronic signature [eSig] feature for the system and for your user account before you can electronically sign your work.

a. If you have eSig privileges, there are two ways you can use the eSig system to sign your work:
   - Perform an event that prompts an Electronic Signature Verification dialog box
   - Select a project, specimen or sample in the Project Navigator pane, then click **Electronic Signature** to open the Electronic Signature Verification dialog box.

b. Complete the information in the Electronic Signature Verification dialog box, then click **OK**.

c. Click **OK** to close the message. If you have eSig privileges, your action is recorded in the Electronic Signature Report.
9 (Optional) Print reports

After analyzing the project and evaluating the results, you can print reports:

a. Select the report you would like to print (see step 2 on page 8 and step 3 on page 9).

b. (Optional) Select the information to display in the report:
   - Report Display Settings – Edit the text properties.
   - Concise Alignment Settings – Select the number of top matches to display (default is 1).
   - Right-click on a table header to select columns to display.

c. Click [Print].

d. (Optional) Edit print properties:
   - Select the paper orientation and size.
   - Click Header/Footer to customize the header and footer.
   - Select Print preview to see the report before printing.

IMPORTANT! If you change the print properties of a Signed project, you must sign the project again (see step 8 on page 9).

e. Click Print.

f. Select a printer, specify the page range, then click OK.